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FIRE BURGLARY INSTRUMENTS, INC.
A Division of Pittway Corporation

165 Eileen Way, Syosset, NY  11791
SOFTWARE LICENSE AGREEMENT

 You should carefully read the following terms and conditions. If you do not consent to be bound by this License Agreement, 
you must promptly return the unopened package to the person from whom you purchased it within fifteen (15) days from date 
of purchase and your money will be refunded to you by that person.  If the person from whom you purchased this Software 
fails to refund your money, contact Fire Burglary Instruments, Inc. immediately at the address shown above. 

Important: This Software is security related. Access should be limited to authorized individuals.

1. GRANT OF LICENSE.  Subject to all terms and conditions hereof, Fire Burglary Instruments, Inc., a subsidiary of Pittway 
Corporation ("FBII") does hereby grant to the purchaser (the "Licensee") upon payment in full of the published license fee, or 
other license fee agreed to in writing (the "License Fee") a nontransferable, non exclusive license to use the enclosed soft-
ware ("Licensed Programs") provided herewith in Licensee's own business on a single computer for a term commencing on 
the date of payment in full of the License Fee and continuing in perpetuity unless terminated in accordance with the terms 
hereof.

2. PROPRIETARY RIGHTS.  License hereby acknowledges that the Licensed Programs including the algorithms contained 
therein are proprietary to FBII.  Licensee shall not sell, transfer, disclose, display or otherwise make available any Licensed 
Programs or copies or portions thereof to any other entity.  Licensee agrees to secure and protect the Licensed Programs so 
as to maintain the proprietary rights of FBII therein, including appropriate instructions to and agreements with its employees.

3. DOCUMENTATION.  The documentation supplied with the Licensed Programs is the copyright property of FBII.  Licensee 
shall not under any circumstances divulge or permit to be divulged such documentation to any other entity.

4.  COPIES.  Licensee shall not copy in whole or in part the Licensed Programs or documentation provided however that Lic-
ensee shall be permitted to make one (1) copy of the Licensed Programs solely for backup purposes provided that all propri-
etary notices are reproduced thereon.  Any such copy shall remain part of the Licensed Programs and shall be subject to this 
agreement.

5.  OBJECT CODE.  Licensee understands and acknowledges that the Licensed Programs consist of object code only and 
that FBII shall not supply source code versions of the Licensed Programs.  Licensee shall not create or attempt to create by 
de-compilation or otherwise, the source code for the Licensed Programs, or any part thereof.

6.  SECURITY.  Licensee acknowledges that the Licensed Programs are security related and access to the Licensed Soft-
ware should be limited to authorized individuals.  Licensee assumes full responsibility for use of the Licensed Programs 
whether by authorized or unauthorized individuals.  Licensee agrees that the License Fee has been set in reliance upon the 
limitation on liability contained herein and that such provisions are fair and not unconscionable.

FBII does not represent that the Licensed Programs may not be compromised or circumvented, that the Licensed Programs 
will prevent any personal injury or property loss by burglary, robbery, fire or otherwise, or that the Licensed Programs will in 
all cases provide adequate warning or protection.   Licensee understands that a properly installed and maintained alarm may 
only reduce the risk of burglary, robbery or fire without warning, but is not insurance or a guarantee that such will not occur or 
that there will be no personal injury or property loss as a result.

 7.  DISCLAIMER OF WARRANTIES.  FBII does not warrant that the Licensed Programs will meet your requirements, that 
operation of the Licensed Programs will be uninterrupted or error-free, or that all Licensed Programs' errors will be corrected.  
The entire risk as to the quality and performance of the Licensed Programs is with you.  THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT ARE DISCLAIMED.  NO 
ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY FBII, ITS EMPLOYEES, DISTRIBUTORS, DEALERS, OR 



AGENTS SHALL INCREASE THE SCOPE OF THE ABOVE WARRANTIES OR CREATE ANY NEW WARRANTIES.  
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU.  IN THAT EVENT, ANY IMPLIED WARRANTIES ARE LIMITED IN DURATION TO NINETY (90) 
DAYS FROM THE DATE OF DELIVERY OF THE LICENSED PROGRAMS.  This warranty gives you specific legal rights.  
You may have other rights, which vary from state to state.  

8.  LIMITATION OF REMEDIES.  Licensee's exclusive remedy shall be either the replacement of any diskette or other media 
not meeting the limited warranty set forth above and which is returned to FBII with a copy of Licensee's paid invoice or, if FBII 
is unable to deliver a replacement that is free of defects, Licensee may terminate this Agreement by returning the Licensed 
Programs and thereupon the License Fee shall be refunded.  FBII shall have no obligation under this Agreement if the 
Licensed Programs are altered or improperly repaired or serviced by anyone other than FBII factory service.  For warranty 
service, return Licensed Programs transportation prepaid, to FBII Factory Service, 165 Eileen Way, Syosset, New York  
11791.

9.  LIMITATION OF LIABILITY.  REGARDLESS OF WHETHER ANY REMEDY SET FORTH IN THIS AGREEMENT FAILS 
OF ITS ESSENTIAL PURPOSE, IN NO EVENT WILL FBII OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY SPECIAL, 
CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, INCLUDING ANY LOST PROFITS OR LOST DATA ARISING 
OUT OF THE USE OR INABILITY TO USE THE LICENSED PROGRAMS OR ANY DATA SUPPLIED THEREWITH EVEN 
IF FBII OR ANYONE ELSE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY 
ANY OTHER PARTY.  THIS PROVISION IS INCLUDED FOR THE BENEFIT OF FBII AND ITS LOCAL REPRESENTA-
TIVES, AND IS ENFORCEABLE BY EACH OF THEM.

SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CON-
SEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

IN NO CASE SHALL THE LIABILITY OF THE LICENSED PROGRAMS' PROVIDERS OR OF FBII EXCEED THE PUR-
CHASE PRICE PAID FOR THE PRODUCT.

10.  REGISTRATION.  In order to qualify to receive notification of FBII updates to the Licensed Programs,  Licensee must 
complete and return a Registration Form to FBII within twenty (20) days from date of purchase.  Notwithstanding, FBII is 
under no obligation to release updates to the Licensed Programs.

11.  TERMINATION.  Upon the breach or non-compliance with any term or provision of this agreement, FBII shall have the 
right to terminate the license granted hereby by written notice to Licensee.  Upon such termination Licensee shall immedi-
ately turn over to FBII all copies of the Licensed Programs and any documentation supplied in connection therewith.  Such 
remedy shall be in addition to an cumulative to any other remedies FBII may have at law or in equity with respect to such 
breach or non-compliance.

12.  GENERAL.  This agreement is the complete and exclusive statement of the understanding of the parties hereto with 
respect to the transaction contemplated hereby and supersedes any and all prior proposals, understandings and agree-
ments.  This Agreement may not be modified or altered except by a written instrument signed by Licensee and an authorized 
representative of FBII, its rights, duties or obligations under this Agreement to any person or entity, in whole or in part.  If any 
provision of this Agreement is invalid under any applicable stature or rule of law it is to that shall be governed by the laws of 
the State of New York and the sole venue for suit shall be in an appropriate state or federal court located in the State and City 
of New York.  The failure of FBII to exercise in any respect any rights provided for herein shall not be deemed a waiver of 
such right or any further Agreement may be brought more than two (2) years after the date such cause of action shall have 
arisen.  FBII shall have the right to collect from Licensee any expensed incurred including attorneys' fees in enforcing its right 
under this agreement. 
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Chapter
1
Welcome

Welcome to the FBII Compass Downloader. It provides
everything you need to program and control an alarm
system remotely from the comfort of your office. In
addition, it gives the operator the ability to download and
upload alarm control information, to compare the
uploaded and saved information, and to view the results
either on screen or in a printed report. 

By using the Compass Downloader, programming can be
performed at the office prior to installation, or can be
downloaded from a remote location.  The control panel at
the subscriber’s premises must be connected to a
telephone line to download from a remote location.

Key Features

The Compass Downloader includes many new features,
such as:

• DOS Downloader Conversion Utility to quickly con-
vert DOS accounts to the Compass Downloader.

• Templates for quick and easy programming of con-
trol panels.

• A full search utility to help you quickly find a pro-
gramming field.

• Multi-tiered operator levels for full flexibility.
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• Change button displays programming changes 
made before saving.

• History button displays prior programming 
changes.

• Unattended Mode enables creation of scheduled 
“batch” jobs, which then communicate with/down-
load to customer control panels at the specified 
time, without the operator being present. 

• Unattended/Unsolicited mode of downloading 
allows the panel to call into the Downloader while 
the computer is unattended.

Recommended System Configuration

• Pentium or better PC-compatible computer

• 16MB RAM

• 50MB available disk space

• CD-ROM drive 

• Windows 95, 98, or NT

• 800 X 600 display resolution.

Year 2000 Information

Compass Downloader for Windows is now Y2K
compliant.  Please note that the computer hardware
(BIOS, etc.) and operating system used to run Compass
Downloader for Windows must also be Y2K compliant to
ensure Compass will run correctly.  If you are uncertain
about the compliance status of your hardware/operating
system, contact your hardware/operating system vendor
for instructions on Y2K testing.  

Manual Structure

This manual will guide you through the many operations
of the Compass Downloader. It is arranged in the order in
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which operations should be performed until you become
familiar with the program.

The manual is divided into ten chapters:

Chapters 1 and 2 include basic information about the
Compass Downloader, such as key features, the
Downloader menu structure, and Downloader installation.

Chapter 3 is a Quick Start guide designed to get the user
up and running quickly.

Chapters 4 and 5 take you through the Downloader setup
and covers those items that only need to be performed
once, such as the modem setup.

Chapters 6 through 9 cover the daily activities performed
with the Downloader. These chapters include adding and
modifying customer accounts and communicating with the
control.

Chapter 10 and Appendix A describe utilities and error
conditions, including troubleshooting.

Getting Product Updates

Any future updates may be acquired via the Internet, from
the FBII web site on the World Wide Web.  You can find
FBII on the Internet at:  

http://www.FBII.com

Using This Manual

Our goal when writing this manual was to make it as easy
to understand as possible. Occasionally, we include an
important note or technical tip to make your work flow
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more smoothly. Find these tips by looking for a boxed
note with a checkmark.

Where applicable, the actual screens are shown to help
you understand the procedure being explained.

Release Notes

Any information that could not be included in this User’s
Guide will be available in the Release Notes which may
be found in the /DOCS directory on the CD-ROM.

Microsoft Windows Basics

As with most Windows programs, the Downloader
program uses keystrokes as an alternative (or addition) to
the mouse. On many of the screens there is a button that
has a dark border around it. This button is called the
default  button.  

If you press ENTER on the keyboard, the default button’s
action will be performed. For example, when you open the
Downloader, the Customer icon is defaulted (dark
border). If you press the ENTER key, you will open the
Customer  Modify screen. 

This symbol indicates a very important note. 

Please read each one carefully. 
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The following commands are also available:

Downloader Program Structure

Compass Downloader consists of three main programs.
When you start the software, the first thing you see after
the logo is the Log In screen.  After you enter a valid
Operator name and password, the Compass “Shell”
screen appears. From this screen you can access
program-wide options such as Logout options, Station
Data, and Operator Setup.  You can also set up Customer
Accounts from the Shell.  (When the Shell is running, you
will see an icon of a house on the Windows 95/98
taskbar.)

From the Customer Accounts list, you can access the
customer account’s Alarm Control Panel configuration.
When you are viewing this data, you are in the Panel Edit
program and you will see an icon on the taskbar that looks
like an eye.  

From the Panel Edit screen, you can go to the
Communications Program and connect to a customer’s
alarm control panel and execute commands on line, such

KEY ACTION

TAB Moves to the next field on the 
screen.

ENTER Performs default button action.

SPACE BAR Fills in check boxes.

ALT+DOWN 
ARROW

Opens selected drop-down choices.

ARROWS Arrow keys can be used as an alter-
native to scroll through choices.

ESC Performs cancel/close action.
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as arming or disarming the panel; programming the panel
configuration (downloading); or uploading configuration
and settings that were programmed into panel previously.
When you are in the Communications program, you will
see a third icon on the taskbar, which looks like two
computers connected with a cable.  

From every program component (Shell, Panel Edit,
Communications), the Help menu provides an “About”
box, which provides the version number of the Compass
Downloader database and the software version of the
program component you are currently using. 

Downloader Menu Structure

Button bars and menu bars are available to make your
selections easy. Selecting the desired option from the
menu bar displays the appropriate screen. If there are
subcategories for this selection, they will appear like the
tabs on a file folder.

Select a screen to view using either the mouse or
keyboard. To make a selection, point at it with the mouse
and click the left mouse button. Notice that as you move
the mouse across the screen, text appears at the bottom
of the screen describing each field, and listing the
programming field number. 

 A sample screen follows.
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Bar
Bar
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Chapter
2
Installation

Installation on a Single PC

1. Insert the Compass Downloader CD-ROM into
your CD-ROM drive. (For information about floppy
disk installation, see page 2-3.)

2. In Windows 95, Windows 98 or NT, from the Start
menu, click Run. In Windows 3.X, select Run from
the Program Manager or File menu.

3. Enter the path to the Setup program on the CD-
ROM drive (i.e., d:\setup).

4. SETUP prompts you through the installation
process. Follow the on-screen instructions.

5. By default, SETUP installs into the C:\COMPASS

directory. If desired, you can change the location
and directory name when prompted to do so.

6. Next, we recommend that SETUP be allowed to
create a backup directory. The backup defaults to
C:\COMPASS\BACKUP. (You may change the location
and directory name when prompted to do so.)

7. When the Select Components screen displays,
make sure all the boxes are checked.

8. Click FINISH to complete the installation.
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Installation on a Network

When you install on a network, you must first install
Compass on your server, and then create shortcuts to the
server installation. Installing to a network directory is
similar to installing on a single PC, as follows:

1. Insert the Compass Downloader CD-ROM into
your CD-ROM drive.

2. In Windows 95, Windows 98 or NT, from the Start
menu, click Run. In Windows 3.X, select Run from
the File menu.

3. Enter the path to the Setup program on the CD-
ROM drive (i.e., d:\setup).

4. SETUP prompts you through the installation
process. Follow the on-screen instructions.

5. By default, SETUP elects to install into the
C:\COMPASS directory. When prompted, change the
location and directory to the network drive and
directory.

6. Next, we recommend that you allow Setup to
create a backup directory. This backup is defaulted
to C:\COMPASS\BACKUP. If desired, change the
location and directory name when prompted.

7. When the Select Components screen displays,
make sure that all the boxes are checked.

8. Click FINISH to complete installation on the server.

9. At each workstation, create a Windows shortcut to
point to the file NETLOAD.EXE on the server.
Whenever you run netload at the workstation, the
dates of all Compass files on the network are
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compared to existing files on the local workstation.
If the network files are newer than the local files,
the system copies these newer files to the local
workstation. Only the database is not copied to the
local workstation. 

Floppy Disk Setup

To facilitate installation on PC systems which do not have
CD-ROM hardware, the Compass Downloader installation
files are set up as floppy disk images on the CD.  

To create an install set on floppy disk: Copy each Setup
disk image to a separate floppy disk  (e.g. setup.exe to
Disk 1, setup.w02 to Disk 2, setup.w03 to Disk 3, etc.) 

To install from floppy disk: Insert Disk 1 into the drive,
select Run from the Start menu, then enter the path
(A:\setup ) and follow the on-screen prompts.

All network workstation installations must 
be directed to the same network drive.

Important Note Regarding Novell Networks

Compass uses the JET database engine. 
When installed on a Novell Network, the 
Novell Server must be set up as follows:
* Max Records per connection: 10,000
* Max File Locks per connection: 350
* Max Record Locks: 20,000
If these settings are incorrect, you will not 
be able to add new accounts to the Down-
loader. These settings can only be changed 
by a Network Administrator.
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Log-On Procedure

After a successful installation, the system creates a
Compass Downloader group that includes an icon titled
Compass Downloader:

If you are using Windows 95 or NT, you will find this icon
under the Program section of the Start menu. Double-click
on this icon to open the program. The Compass logo
screen is displayed, followed by the Log In screen:

Enter an operator name and password. The default
operator name and password is master. Anyone with a
valid operator name and password can log in. 

The operator who is currently logged in is displayed in the
upper right-hand side of the Customer Information screen.

Use the DATABASE button to select the path to the
database you will be using.
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An option available from the Shell menu permits the
administrator to determine what is left or cleared of the
operator name and password on the Log On screen after
the LOGOUT button is pressed. Select the FILE menu option
and then the LOGOUT OPTIONS menu. Three different
options are available:

• Clear Name / PW (Password)

• Keep Name / Clear PW (Password)

• Keep Name and PW (Password)

Logging Out

To log out, simply click on the LOGOUT icon. This brings
you back to the Log On screen.

To exit the program completely, click on the EXIT button.

For security reasons, we recommend that 
you change the default operator name and 
password. For information, refer to Chapter 
5: Defining System Operators
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Chapter
3
Quick Start

Quick Start is intended for users who would like to get the
Downloader up and running quickly. To take full
advantage of the many fine features of the Compass
Downloader, we recommend that you read the rest of this
manual.

Setting Up the Downloader

1. Click on the COMPASS DOWNLOADER icon from the
Downloader program group.

2. Enter the operator name and password (master is
the default for both) and select the OK button.
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3. Select STATION DATA from the File menu. The
following screen appears:

4. Enter your Computer Station Identification
(C.S.I.D.) number and select OK.

5. Click on the MODEMS button: 

The following screen appears
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:

6. In the Company section, select the Company
whose controls you will be communicating with.

7. In the Modem section, select the Comm Port to be
used.

8. Select the type of modem being used from the
Modem pulldown menu, then click Apply.

9. Select TOUCH TONE if you are using Touch Tone
service.

10.Select the modem speaker options (Speaker On/
Off, volume, etc.) 

11.Click OK.
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Creating a New Account

1. Click on the CUSTOMER button. The following
screen is displayed

2. Click on the ADD button in the Customer Options
frame.  The Customer Detail screen appears.

3. Enter the account information (i.e., name, address,
etc.).  Also enter the Receiver Group account #
and panel type. 
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4. Click OK.

5. Click on the MODIFY button in the Panel Options
frame.

6. Enter the control panel configuration information.  

7. Click on CLOSE and then select SAVE to save the
configuration. You will be returned to the Customer
list in the Shell. Repeat these steps to continue
adding customer accounts; or go to the next
section to download saved configuration data to
the control panel, or to send commands to the
control panel.

Getting On-Line With the Control Panel

Control Panel Preparation:  Using the specific control
panel installation instructions as a guide, perform the
following steps:

Communicating With the Downloader
1. From the Customers screen (click Customers

toolbar button), select the desired customer record.
Then, click the Modify button in Panel Options.

2. Select the Communications menu option from the
screen that appears. 
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3. Click on the CONNECT button. The following screen
appears:

4. Select PC from the Initiate From box.

5. Select FIRST TIME COMMUNICATION if the panel has
never been downloaded to before. Select USE

ACCOUNT C.S.I.D. if it has been downloaded to
before.

6. If this is a First Time Communication, but there is
an account # in the control panel, make sure ACCT.
# IN PANEL is checked.

7. Enter the control panel phone number.

8. Click on the CONNECT button.

The PC calls the control panel. A series of SEND (>>) and
RECEIVE (<<) arrows appears at the bottom of the
screen.  The modem disconnects and waits for the control
panel to call back if the control panel has Callback option
set.

“Initiate
From” 
Box
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9. When the control panel calls back and goes on-
line, select the action you wish to perform from the
On-line Commands (Download, Upload, etc.).

10.When you are finished communicating, click on the
DISCONNECT button.

 DOS EZ-Mate Conversion

For information on converting existing FBII DOS EZ-Mate
accounts to Compass Windows Downloader accounts,
refer to “Converting Accounts from EZ-Mate” on page 6-3.
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Chapter
4
Communications Setup

Downloader Communications Setup

To set up Downloader communications, click on the
MODEMS button on the Compass shell screen.

The following screen appears:
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1. Select the company whose panels you will
communicate with.

2. In the Modem section, select the CommPort to be
used for that company’s controls.

3. Select the type of modem being used from the
pulldown menu.

4. Select TOUCH TONE if using Touch Tone service
and select the modem speaker options.

5. Click OK.

Modem Setup

The following modems are supported and need no
configuration:

• Hayes Optima 336 External

• Hayes Smartmodem 2400

• Hayes Smartmodem Optima 2400 Fax96

• ADEMCO CIA 2400

The following modems are supported and need to be
configured (DIP switches):

• Hayes Smartmodem 1200 with volume external

• Hayes Smartmodem 1200 External Modem

• Hayes Smartmodem 1200B Internal Modem 
(Rev.1.2 or higher)

Only the external Hayes Optima 336 is a
compatible modem. The internal model
will not work with this product.
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Configuration

This section provides a guide for configuring modems that
have manual switch settings.

Hayes Smartmodem 1200 External Modem

Configure the DIP switches behind the modem’s front
panel in the following manner:

Hayes Smartmodem 1200(B) Internal Modem

DIP switches:

• SW4 - OFF

• SW3 - ON

• SW2 - OFF

• SW1 - ON= Comport #2

•           OFF= Comport #3

Only the external Hayes Smartmodem
96 modems areOptima 24 Plus FAX  

compatible with the Compass Downloader. 
The internal Hayes Optima 24 Plus FAX 96 
models are not compatible.

DIP Switches

1 2 3 4 5 6 7 8 109

HS AA CD OH RD SD TR MR

(front)Hayes 1200 Smartmodem

Exploded View

Smartmodem 1200 External Modem
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Add Modems

1. Click the ADD MODEM button. The following screen
appears:

1
2
3
4

Phone

Phone

(rear view)

DIP
Switches

Smartmodem 1200 (B) Internal Modem

We strongly recommend using the modems

:
featured in this chapter, as they are the
only modems currently supported. To add a 
new modem, proceed as follows.
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2. Give the modem a name.

3. Enter modem commands or click the TEMPLATE
button and select the modem template to be used.

4. If your modem supports the Caller I.D. feature, you
can enable the Caller I.D. Command on the
Support frame here.

5. If the modem software can control the volume, click
SOFTWARE VOL CONTROL on the Support frame.

6. Click OK.

FBII F7702 Interface

The frame titled FBII F7702 Interface, on the Modem
Setup Screen, is used to set the options available for that
interface.

The F7702 Required option is only used
if the company is set to FBII.
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The following options appear in this frame:

F7702 Required - If checked, this box shows the operator
that the F7702 Interface is required.

Local Code - This refers to the code passed to the model
F7702 Interface to place it in local mode.  The default of
‘**’ should work fine; however, it may be changed to any
two digits (including * or #) to suit your line needs.  This
mode is programmable on F7702Interface.  Refer to the
F7702 Interface User Guide for programming instructions.

Remote Code - This refers to the code passed to the
F7702 Interface to place it in remote mode.  The default of
‘**’ should work fine; however, it may be changed to any
two digits (including * or #) to suit your line needs.  This
mode is programmable on the F7702 Interface.  Refer to
F7702 Interface User Guide for programming instructions.

Ring Count - This box shows the number of rings for the
F7702 Interface.

Carrier Duration - This box shows the carrier duration for
the F7702 Interface.

Mode (Modem Interface Select) - This field controls the
operation of the F7702 Interface.  When performing
remote communications with the F7702 Interface, set this
field to enable Remote.  When performing local
communications, set this field to enable Local.  Choose
NONE when the F7702 Interface is not being used.

Event Log - This screen allows you to view previously
uploaded logs.
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Edit Modem

Use this button to edit the modem commands only for
those modems that are added to the Downloader. Modem
settings that were shipped with the Downloader are not
editable. To edit a modem’s settings:

1. Select the modem from the Modem dropdown list.

2. Click on the EDIT button.

3. Enter modem commands.

4. Click on OK to save the new commands, or click on
CANCEL to exit without saving.

Delete Modem

This button is used to delete modems that have been
added by an operator. Modems that were shipped with
the Downloader cannot be deleted. To delete an operator-
installed modem:

1. Select the modem from the Modem dropdown list.

2. Click on the DELETE button.

3. Click OK to confirm the deletion.

Computer Station I.D.

The Computer Station Identification number is used as a
means of storing the identity of the company that installed
the control panel. This prevents unauthorized remote
access to the panel. This number is transmitted by the
computer and is verified by the control panel during an
attempt to get on-line for downloading. This number must
be 8 characters consisting of (0-9, A-F) for ADEMCO
panels. Only the first 6 characters are used for FBII. This
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ID is not used for Apex panels. This number is assigned
by your administrator.

To enter your Computer Station I.D. (C.S.I.D.), select FILE

from the menu bar at the top of the Customer screen. In
the pulldown menu, select STATION DATA. Only an
administrator can get to this screen. Then locate the
Station C.S.I.D. field. Enter your Station C.S.I.D. number.
Select OK to save and exit, or CANCEL to exit without
saving. The Station C.S.I.D. will be used for any new or
defaulted accounts. Once an account has been saved,
the C.S.I.D. for that account is stored in that account, so
that a change to the Station C.S.I.D. will not change the
account C.S.I.D.

An operator can (when given the authority) view or
change the C.S.I.D. on the Dialer screen when modifying
an alarm control panel. To change the C.S.I.D. of an
existing account, go to the Communications screen and
connect to the panel. While connected, press the MODIFY
button and change the C.S.I.D. on the Dialer screen.
Then download the panel.

You can download the current station C.S.I.D. to all
Compass-downloaded panels by selecting WRITE C.S.I.D.
ON DOWNLOAD. This changes the C.S.I.D. to the new
C.S.I.D. specified in the station. When the VIEW C.S.I.D.
button is pressed, the system displays the new station
C.S.I.D.
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User-Defined Fields

There are two fields on the Station Data screen. The
operator can customize these fields and then use them on
the Customer Information screen as sort criteria to help
organize customer accounts (i.e., residential, commercial,
etc.).
Communications Setup  4-9



1. Select STATION DATA from the File pulldown menu
(at the top of the Customer Information screen).
The following screen appears:

The Current Customer Class section allows you to enter a
classification for a group of customers. The class is
assigned to a customer account on the Customer Detail
screen. It is used for sorting and search functions, e.g.,
Commercial Accounts, Residential, etc.

2. Type the field name to be used into the two boxes
under User_Defined_Field Caption. 

3. Click OK.

When renaming these fields, the new name also appears
in the Sort By box located on the Customer screen. A
custom Sort feature has now been created.

User- 
Defined
Fields

Only an operator with Administrator
 privileges can access the User-Defined

Fields.
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Chapter
5
Defining System Operators

After setting up your communications options, the next
step is to define Downloader system operators. Operators
can be assigned different levels of authority, which allow
them access to various system and control panel
operations.

Once you have logged on, look for the button marked
OPERATORS on the Compass shell screen.   Clicking on
this button brings you to the Operators screen. 

Only an operator with Administrator level 
authority can access the Operator screen. 

User 
Screen
Access

Subscriber
Access 

Other
Access 

Operator 
Command
Buttons 

Operator
Names
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This screen defines the security level of all operators of
the system. You are not allowed to exit the screen unless
at least one operator is defined as an Administrator.

Adding New Operators

To add new operators:

1. Click on the ADD button on the bottom of the
Operators screen.

2. The screen changes slightly, allowing you to type
in an operator’s name and password. The
password must be typed twice to confirm it.

3. Select the access properties for that operator using
the access definitions listed below as a guide.

4. Click on the OK button to save the addition. 

5. To continue adding operators, repeat steps 1-4.
When you have finished, click on CLOSE.

User Screen Access Definitions
User Screen Access: Allows operator to view control panel 

User screen when modifying control 
panel programming.

View User Code: Allows operator to view control panel 
user codes.

Add Users: Allows operator to add control panel 
user codes.

Modify Users: Allows operator to edit or delete con-
trol panel user codes.

Subscriber Access Definitions
Add: Allows operator to add new custom-

ers to database.

Edit: Allows operator to edit existing cus-
tomer information.
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Delete: Allows operator to delete customers 
from database.

Modify Panels: Allows operator to access and 
change alarm control information.

Import/Export: Allows operator to import/export 
Compass accounts.

Other Access Definitions
Administrator: Allows the operator full access to the 

Operator screen. Without this option, 
the operator cannot view the Opera-
tor or Station Data screens.

Convert Accounts: Allows operator access to the Con-
vert DOS Accounts screen.

Restore/Purge Customers: Allows operator to restore or com-
pletely purge customer accounts.

Print Data: Allows operator to print all alarm 
control information.

Zone Screen Enabled: Allows operator access to the Zone 
Information screen for the control.

History Screen Enabled: Allows operator access to the His-
tory Screen for the control.

Template Screen Enabled: Allows operator access to the Create 
Templates screen.

View C.S.I.D. in Panels: Allows operator to view the Com-
puter Station Identification Number.

Change C.S.I.D. in Panels: Allows operator to change the Com-
puter Station Identification Number.

Edit Import Subscribers: Allows operator to change import 
subscriber options and settings.

Communications: Allows operator to communicate with 
panels.

If you do not want an operator to have 
to the Operators screen, disable the 

Administrator option for that operator.
access
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Changing Operator Names

If you want to change an operator’s name, highlight it in
the Name box and type in the new name, then click the
UPDATE button. 

Changing Operator Passwords

Only an operator with Administrator level can change an
operator’s password. If an operator forgets or wants to
change his password, an Administrator can assign a new
password by taking the following steps:

1. Select the operator’s name from the Current
Operator List.

2. Click on the CHANGE PASSWORD button. The
Change Password screen is displayed.

3. Assign the new password and verify it by entering it
again.

4. Click on the OK button.
5-4 Defining System Operators



Updating Operator Information

At any time, you can update or change an operator’s
access status by doing the following:

1. Select the operator from the Current Operator list.

2. Modify the characteristics for the operator.

3. Click on UPDATE.

Deleting Operators

To delete an operator, click on the operator’s name from
the Current Operators box and click on the DELETE button.

Current 

List
Operator 
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Chapter
6
Customer Information

The first step in defining account information is to set up
your customer database. This is performed on the
Customer List screen.

Adding Customer Accounts

To add a new customer account:

1. Log in to Compass. 

2. Click the CUSTOMER button.

Sort By
 Box

Customer 
Accounts
Grid 

Search
Options
Box

Box
Options
Customer 
Customer Information  6-1



3. Click on the ADD button from the Customer Options
box. The screen displayed allows you to add
customer information. 

4. Tab through the screen to move from field to field.
You must fill in the Receiver Group number (up to 6
characters), a 3- or 4-digit Subscriber Account
Number, Panel Type, and Revision Number. The
Revision Number defaults to the most recent,
based on the panel selected.

The revision determines which programming 
fields the Downloader displays. Make sure 

uncertain of the revision, select the highest 
available.

you select the revision you have. If you are
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5. To save the new account and exit the Detail
screen, click OK. To exit without saving the
information, click CANCEL.

Converting Accounts from EZ-Mate

This section describes converting existing EZ-Mate
accounts to Compass Downloader accounts.

1. Start the Downloader by double-clicking on the
DOWNLOADER icon in the Downloader group.

2. Log on to the Downloader.

3. Select CONVERT DOS ACCOUNTS from the Tools
pull-down menu. The Convert Mode Message box
appears. If you are using a shared database, press
NO to continue; otherwise, press YES to speed up
DOS conversion. The following screen appears:

4. Select the Panel Type and enter the DOS
Downloader Master Code.

5. Navigate to the directory where the EZ-Mate
accounts are located.

6. Select the appropriate FBII DOS Index files to be
converted and click OK. A DOS Master Code is
required for  FBII. 

DOS Index
Files FBII
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7. After you select the appropriate Index file and click
OK, the Downloader Data Exchange screen is
displayed.

8. Highlight the DOS files to be converted by left-
clicking the mouse in the RCVR column of the grid

A prompt may appear if the primary phone # from the
DOS account does not have an assigned receiver group.
This mapping is essential for proper operation of
Unsolicited and Panel Initiated Unattended modes. 

To add a receiver Group/Phone #, answer YES to this
prompt:

“NO MATCH FOR PRIMARY PHONE NUMBER ‘*&3’ IN RECEIVER

GROUP TABLE.  DO YOU WANT TO ADD THIS PHONE NUMBER

TO RECEIVER GROUP TABLE?”  Then, do the following:

• Type in the receiver group you wish to 
assign to the account phone number 
listed in red.

• Press the OK button.

• Press the CLOSE button to close the 
screen and continue  converting DOS 
accounts.

Download.ini Option
This option is for advanced operators only.

You can modify the download.ini file in your C:\Windows
directory so that receiver groups will be automatically
assigned to the accounts you are converting.

This feature is available by setting the following line to 1
(default is 0):

[DOS Convert]
Auto_Create_Receiver_Group=1 

A receiver group of P + the last 5 digits of the primary
phone number will be created and used for all those
accounts converted from DOS having that primary phone
number.
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and clicking on the SELECTED button to convert the
accounts. If all the accounts are to be converted,
click on the ALL button. If only certain control panel
types are to be converted, select those panel types
from the pulldown menu. Only those types of
controls appear.

9. The converted accounts are listed on the right-
hand side of the screen above. When all selected
accounts are converted, select EXIT from the File
pulldown menu.

10.To convert a different Index file, select OPEN DOS
from the File pulldown menu.

Changing Customer Account Information

At any time, you can change customer account
information as follows: 

DOS Index Windows
Download
Files

Files

The original EZ-Mate accounts  
are not altered by the conversion 
to Compass.  The conversion copies these
accounts and leaves the originals 
unchanged. 
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1. Click on the customer account you would like to
change from the Customer Accounts listing.

2. Click DETAIL in the Customer Option box.  

3. Make the necessary changes. To print the
customer account information changes, click PRINT.

4. Click on the OK button, or CANCEL to exit without
saving the changes.

Deleting Customer Accounts

Deleting a customer is a two-step process. To delete a
customer:

1. Click on the customer’s name from the Customer
Account list.

2. Click DELETE. The following screen appears: 

3. Select either Delete Selected (deletes highlighted
accounts only) or Delete All (deletes all accounts
displayed in the customer grid) and click OK. Click
CANCEL to keep it. 
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See “Restoring/Purging Customer Accounts” below to
complete the deletion process.

Restoring/Purging Customer Accounts

This is Step 2 in the deletion process. When you delete a
customer as described above, the information is not
completely lost. You must then “purge” the account to
completely delete it. Whether you want to restore or purge
an account, the first step is the same:

1. From the Tools pull-down menu (at the top of the
Customer Information screen), select RESTORE/
PURGE CUSTOMER. The following screen appears:

2. To purge accounts, select the accounts by clicking
the desired rows in the Rcvr-Acct # column. The
selected accounts will be highlighted in yellow.  

An account must be purged before that 
account number and receiver  number can 
be used again. Be very careful when using
the Purge capability.

Deleted 
Accounts
List

Locking
Options
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An additional option exists which can be used to
lock the Restore/Purge grid to a specified receiver
or receiver + account.  This causes only the
accounts that match the lock to be visible here.
This option is located in the lower left of the
Restore/Puge Accounts screen.

3. Press the PURGE CUSTOMER button.  The following
screen appears:

You can choose to purge the highlighted accounts
or all accounts displayed on the screen.  Click OK
to purge.

4. To restore an account, select the account and click
on the RESTORE button. 

5. Click OK to confirm your selection.

Sorting Customer Data

There are several different ways to sort customer
information for display.  Clicking on the SORT BY box
presents different options.  A sort can be done by:

• Receiver Account Number

• Last Name

• First Name

• Zip Code
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• Business

• Panel Phone

• User_Defined_Field 1(Name defined if field used)

• User_Defined_Field 2(Name defined if field used)

To select the sort method, either click on the selection
from the pull-down box or type the corresponding number.
As a reminder, the field that you selected to sort by is
italicized on the screen.

The option of sorting by panel name  has been moved to
the Search Options frame on the Customer List screen.
To select by panel name, do the following:

1.  From the Panel list, choose the panel type to find.

2.  If all revisions of that panel type are desired, click
ALL REVS. 

3.  Click SEARCH. The SEARCH button refreshes the
customer grid.

4.  To view all accounts, click ALL ACCOUNTS.

Searching for Customer Accounts

The Search feature works with the Sort feature. When a
sort method is chosen (Acct.#, Last Name, etc.), that
method is also available in the Search box.  

1. Enter the Receiver Number or the beginning of the
sort method chosen.

2. Click on the SEARCH button. The result of your
search appears. 
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3. To display all the customer accounts again, click
on the ALL ACCOUNTS button.

Purging History Data

This option allows an administrative operator the ability to
delete history data from the Compass database.  This
history is the data viewed on the History screen within the
Panel Modify screen of each account.  To access the
Purge History screen:

1. At the Customer List screen, click FILE on the main
menu bar.

2. Click PURGE HISTORY.

3. Select either ALL ACCOUNTS or SPECIFIC RECEIVER/
ACCOUNT.  ALL ACCOUNTS allows the operator to
purge the history for all the accounts with dates
either “6 months or older” or “12 months or older.”
SPECIFIC RECEIVER/ACCOUNT adds an additional
date range of “all history.”

4. Click PURGE HISTORY to continue.

5. Click CLOSE.

Renaming Receiver Group

1. From the Tools menu, choose RENAME RECEIVER

GROUP.  

2. On the screen that appears, type the old receiver
name in the appropriately marked box.  

If there are more than 1024 accounts in the
database, the Search option must be used
to narrow down the # of accounts displayed. 
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3. Type the new name in the New Receiver Name
box.  

4. Press the CHECK CONFLICTS button to make sure
the change will not create duplicate Receiver
Group/Account number information. If there are no
conflicts, press the RENAME RECEIVER button to
change the Receiver Group name. 

5. If there are conflicts,  reassign the accounts that do
not conflict to the new Receiver Name by checking
the RENAME ACCOUNTS NOT IN CONFLICT box.

6. Press the CLOSE button to return to the Customer
screen.

Exporting and Importing Accounts

This feature gives you the ability to copy a single account
from one computer to another.  The ability to export and
import an account is useful when a technician is sent to a
job site with a laptop computer.  

When exporting an account, copy the account from your
current Compass database to a drive on a network or to a
floppy disk.

When importing an account, copy the account from a
network drive or a floppy disk to your current Compass
database. 
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To export an account, do the following:

1. Select an account from the customer list.

2. On the Customer Account screen, click on TOOLS

on the main menu bar.

3. Under Tools, click on EXPORT ACCOUNT.                   

4. A window appears entitled “Save Exported
Account As.”  Select the name of the file the
account will be saved as. Make sure the name has
an extension of “.wdl.”

5. Select the drive to which  the file will be copied.

6. Select the directory on that drive where the file will
be copied to.

7. Click OK.

To import an account, do the following:

1. On the Customer Account screen, click on TOOLS
on the main menu bar.

2. Under Tools, click on IMPORT.                   

3. A window appears entitled “Select File to Import an
Account.” Select the drive where the file to be
copied is located.

4. Select the directory on that drive where the file to
be copied is located.

5. Select the file with the account to be copied.

6. Click OK.

Customer Account Screen Layout

You can customize the way the Customer List displays
accounts.  To change column order, click on a column
heading and drag it to the column position you want.  To
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change the column width,click on the right-hand edge of
the column and drag to the left to narrow it, to the right to
widen it.  To save this layout, as well as Search Options,
do the following:

1. Click on OPTIONS on the menu bar.

2. Click on SAVE & USE LAYOUT. You will see a check
mark next time you go to the Options Menu.  Every
time the option is selected, it toggles either on or
off. With the option on, every time the Downloader
is exited, the screen layout is saved. 

3. To restore the original customer grid layout, click
on the Restore button   !  located in the upper left
corner of the grid.

Restore
Customer
Grid Layout
Button
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Chapter
7
Control Panel Information

Alarm Control Programming Overview

To access the Alarm Control Programming (Panel Edit)
screens, either double-click on the highlighted customer
account in the Customer screen or highlight the customer
and click on the MODIFY button.

Modify
Button
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 The following screen is displayed:

At the top of the screen is the title bar. It identifies the
control panel type and revision and the receiver/account
number of the customer you selected. Below this is the
menu bar. The options in the menu bar are not control
panel-specific; they are Downloader operations. These
options are as follows:

File
Save: Allows an operator to save the alarm 

control settings.

Printer Setup: Allows an operator to select and set 
up the printer.

Print Programming Form Allows  an   operator  to   print  a pro-
gramming form that reflects the cur-
rent Downloader settings.

Exit: Allows an operator to exit the Panel 
Edit screen.

Communications!

Takes you to the Compass Communications screen.
Allows an operator to upload or download information to

Menu 

Button 
Bar

Bar
Title Bar
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the panel, providing the ability to arm, disarm, retrieve
status, bypass zones, and send messages.

View

The View modes give the operator the ability to see
different versions of a control’s programming. This allows
the operator to view the values saved in the Downloader,
values uploaded from the control, converted DOS values,
default values, or a current edit not yet saved. The screen
being viewed is indicated in the upper right corner of the
title bar.

Current Edit: Allows an operator to view the 
changes just made (not saved yet) 
to the control programming.

Upload: Allows an operator to view the data 
last uploaded from the  alarm con-
trol.

Saved: Allows an operator to view the previ-
ously saved  data.

DOS: Allows an operator to view the  DOS-
converted Downloader programming 
information.

Defaults: Allows an operator to view the pro-
gramming defaults for a control 
panel. (Some panels have multiple 
default options available.  For these 
panels, a default selection must be 
made, e.g.,1, 2, 3,...etc.)

Search

Allows an operator to search for a specific programming
option by field number or name. To do this, select SEARCH

from the Panel Edit screen. The following screen is
displayed:
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 To begin the search, proceed as follows:

1. Enter the programming field number or part of the
field name that you are looking for.

2. Click on the FIND FIRST button. If you want to go to
the field in the programming screens, click on the
GO TO button.

3. If FIND FIRST did not bring you to the option you
wanted, press FIND NEXT to go to the next option
matching the criteria.  Use FIND PREVIOUS to go
back to an option.

Features

This menu displays the same options as those on the
button bar, as well as the available hot keys.
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Window

Presents normal Windows features such as cascading
and arranging screens, and displays screens currently
open.

Help

Pulls down the Help menu. Select ABOUT to view the
version and release date of the Compass Database and
of the Panel Edit module for the panel you are modifying..

Programming an Alarm Control

1. Either double-click on the account in the Customer
screen or select the account and click the MODIFY
button. The following screen appears. (This screen
varies according to the features of the control panel
selected.)
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2. Select from the button bar which section ( Dialer,
Zones, etc.) to program.

3. Enter the control panel programming information. 

4. When you are finished  programming, Select the
CLOSE button. This screen appears:

5. To save the programming information, click  the
SAVE button.  To close without saving, click UNDO.
To return to the Panel Edit screen, select CANCEL. 

Using Templates

Templates are used to create “master” files for control
panel programming data to speed programming of a new
account. A template gives you a very quick and easy way
to add a customer’s alarm control programming
information. 

To access the Template screen, click on the TEMPLATES

button at the top of the Customer List screen. 

The following screen appears:
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Creating New Templates

To create a new template:

1. Click on the ADD button. The screen displayed
allows you to enter the control panel type, the
revision, and a name for this template.

2. Click on OK to save, or CANCEL to exit without
saving. 

3. Click on the MODIFY button to edit the alarm control
panel programming for this template.

Template
Options
Buttons

Template 
Lists
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4. When you are finished programming the control
panel, select CLOSE and then SAVE to save the
information.

Modifying Templates

To modify an existing template:

1. Click on the TEMPLATES button at the top of the
Customer Information screen.

2. Select the template from the Templates list.

3. Click on the MODIFY button. You will be brought into
the selected alarm control Panel Edit screen to
program the template information.

4. When you are finished setting up the template,
select CLOSE and then SAVE to save the
information.

Deleting Templates

To delete a template:

1. Click on the TEMPLATE button at the top of the
Customer Information screen.

2. Highlight the template on the list.

3. Click on the DELETE button. 

4. Click on OK to delete, or CANCEL to exit without
deleting.

Setting Up an Existing Customer Template

To use another customer’s account data as a template:

1. Follow steps 1 and 2 from “Creating New
Templates” above.
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2. Select the CUSTOMER DATA button. A form appears
that allows entry of the receiver # and the account
# of the customer account to be copied. 

3. Select OK to copy that customer into the template
or CANCEL  to exit. 

4. Click OK to confirm  copy function.

Using a Template to Create a New Account

Templates are used to speed the process of programming
a control panel. To use a template to program a control:

1. Either create a new account or highlight on the
Customer Information screen the account that the
template is to be applied to.

2. Click on the TEMPLATE button at the bottom of the
Customer screen. 

The following screen appears:

3. Highlight the template that will be applied to the
account. Click OK.
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4. Confirm the template selection by clicking OK. The
control panel will now be programmed to match the
template.

Copying an Account

The Copy command can be used in place of Templates to
copy programming information quickly from one control to
another. To copy an account:

1. Click on the COPY button. The following screen
appears:

2. Enter the receiver and account number of the
control panel to be copied from.

3. Enter the receiver and account number of the
panel to be copied to, or check the CREATE NEW

PANEL box.

4. Click OK. The new account will now be copied from
the source account.

An account can be copied only to another 
account that uses the same control panel 
type and revision.
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Chapter
8
Interactive Communications

How to Communicate On-Line 

The following chapter contains information on Interactive
Communications for FBII control panels.  

Getting On-line (FBII)

Panel Communications

Double-click on the applicable account to access the
programming fields for the selected  panel or select the
account and click the MODIFY button.

We recommend you only initiate Scheduled jobs from 
the Shell, even though the Communications screen 
(next page) contains a “Schedule” button.  If you 
select Scheduled from the Communications screen, 
you must then exit from this screen and from the 
Panel Edit screen before any scheduled jobs will be 
initiated.   Refer to Chapter 9, Unattended Communi-
cations, for instructions on Scheduled mode.
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Select Communications! from the menu.  The following
screen appears:

Click CONNECT.  Compass will initiate communications
with the panel.  Once on-line, you can modify the existing
account programming information or perform a number of
on-line commands.

On-Line Commands (FBII)

On-Line Commands vary, depending on the panel you
have selected.  The following are typical On-Line
Commands and their explanations.  

efer to Chapter 9
or instructions on
sing Scheduled
ode.

Download To download programming information to the panel,
choose DOWNLOAD.

Upload To upload programming information from the panel to
the downloader, choose UPLOAD.

Status To determine the status of the panel that is on-line with
the downloader, choose STATUS.

Arm To arm the panel from the downloader, choose ARM.

Disarm To disarm an armed panel, or a panel in alarm, choose
DISARM. 
8-2 Interactive Communications



Click on a command in the Commands box and then click
on the > button or double-click on a command.  Once you
choose a command, it appears in the Selected
Commands box.  To remove a selected command, click
on the < button.  To remove all commands, click on the <<
button.

Some commands, such as Arm or Bypass, require
additional clarification (e.g., arm-stay, arm-away, bypass
zone 2, etc.).  These selections can be made from the
dropdown Options list located in the middle of the screen.

Modem Setup -This screen allows you to choose the mo-
dem and parameters for remote communication.

Zone Bypass To bypass faulted zones via the downloader, choose
ZONE BYPASS.

Event Log Upload To upload an event log from the panel, choose EVENT
LOG UPLOAD.

Event Log Clear To clear an existing event log from the panel, choose
EVENT LOG CLEAR.

Time Set To set the time, use TIME SET.
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Options (FBII)

The following selections appear in the Options menu:

Show Activity - Displays >> on send/receive of
characters on the bar shown above.

Turbo Mode - If this option is selected, no status request
occurs between commands.  A status request will only be
sent if there are no pending commands or if the command
requires a status command to end.

Auto Initialize Modem - This option initializes the modem
on connect.

Connect Speed - The following three choices exist for
connect speed:

• Normal Connect

• Fast Connect

• Super Fast Connect
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Problematic Modem - Alternate AT/Hangup (Bad
Modem Cable).

Set Time On Disconnect - The following three  choices
exist under this option:

• Always

• Never

• Prompt
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FBII F7702 Interface

The frame titled FBII F7702 Interface, on the Modem
Setup Screen, is used to set the options available for that
interface.

See Chapter 4 for a detailed description of the F7702
options.
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Chapter
9
Unattended Communications

Unattended Operation

The purpose of Unattended Operation is to allow you to
communicate with the control panel at the installation site
from the office computer without an operator at the
computer. There are now three separate types of
Unattended modes available in Compass.  These
methods are called Unsolicited, Scheduled, and Mixed
modes.   

Unsolicited Mode

In unsolicited mode, a panel calls in to the Server without
the Server’s prior knowledge of the call-in.  Once the
panel has gotten the Server’s attention, the Server must
determine what type of panel it is communicating with and
perform the appropriate task.

Scheduled Mode

In scheduled mode, the Server checks for scheduled
commands (e.g. arm, upload, etc.) to be performed on a
panel at a certain time.  At the scheduled time, the Server
performs the tasks scheduled by the operator for the
panel.

Mixed Mode

In mixed mode (with both Unsolicited and Scheduled acti-
vated), the Server operates in Unsolicited and Scheduled
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modes simultaneously.  The Server executes scheduled
jobs at their selected times; and, when not busy, answers
unsolicited calls.  This is the default mode and recom-
mended mode of unattended operation.

How to Use  Unattended Mode  

Starting the Unattended Server

To start the Unattended Server, click on the UNATTENDED
button at the top of the Customer Information screen.  The
following prompt will appear:

Select FBII.  Click on the OK button. To use both
communications servers, you need to have them on
different Comm Ports of the computer, connected to two
separate phone lines.  

FBII Unattended Communications

How to Select FBII Unattended Mode
1. Click the Unattended button from the Compass

Shell screen. 

2. The server is started automatically.

3. If you want to select Unattended options, click on
the STOP button to stop the server.  Then click
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Options on the Menu Bar.  The following drop-
down menu appears:

4. Click on one or both of the bottom two entries
(Unsolicited Server Activated and/or Scheduled
Server Activated) depending on which Unattended
Mode is desired.  Activating both servers turns on
Mixed Mode.  

5. Click on the Start Button to reactivate the server.
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How to Schedule FBII Unattended Jobs 

Be sure the Unattended Server has been started before
scheduling jobs.  To schedule Unattended jobs, take the
following steps:

1. Either select the account on the Customer screen
and click the SCHEDULE button, or go to the
Communications screen shown below (available
from the Panel Edit screen.)

Some panels do not have the Unattended ID 
feature.  Refer to the Installation Instruc-
tions for the panel with which you are com-
municating, to determine whether it has this 
feature.  If the panel does not have the Unat-
tended ID feature, make sure there is no 
Callback Number programmed into the 
panel.
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2. Highlight the desired commands in the Available
Commands area on the left side of the screen.

3. Click on the top arrow in the center of the screen to
move the desired command into the Selected
Commands area on the right side of the screen.

4. The command may have options associated with it
(e.g., Arm Away, Arm Stay, etc.).  These options
will appear in the center of the screen.  After a
command has been selected from the right-hand
area, it can be modified by clicking on the EDIT
button (small pencil in upper right of the screen).

5. When all selections have been made, click the
SCHEDULE button in the lower center of the screen.
The following screen appears:

6. Set the start and end dates and time for this batch.

7. Click OK to complete the Unattended scheduling.
You will be returned to the Customer Information
screen. 
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How FBII Unsolicited Mode Works
1. The Unattended Server is started, and listens for

incoming calls.

2. The  panel calls in.

3. The server identifies the panel type and extracts
the unattended ID from panel.  The Unattended ID
from the panel is used to locate the correct
Compass Account within the Downloader.

4. Once the Compass Account has been found, the
server will download the Compass Account data to
the panel. 

Setting Up FBII Panel To Call Unsolicited Server

The Unattended Account ID number must be installed in
the FBII panel.  This value is retrieved from an existing
Compass Account.  To obtain this data take the following
steps:

1. Go to Compass Customer Screen and find or
create the Compass Account of interest.  Highlight
the Compass Account and depress the following
keys:

<SHIFT> + <CTRL> + ?

A box, with information about the Compass
Account being highlighted appears: 
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2. Search for the Account ID value in the FBII panel's
unattended ID area.  Once this is done, the FBII
panel can call the Server at any time.  Note: The
account ID must be preceded by a string of zeroes
when being entered into the panel, such that the
entire number is exactly 12 digits long (i.e., for the
above account the number to enter in the panel
would be 000000004003).
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Chapter
10
Utilities

Synchronizing the Database

The Download.mdb database is automatically
synchronized to the new table format at the end of the
Compass installation.   The synchronization adds in new
tables and fields to Download.mdb while ensuring that
previous data is not lost.  Compass will not run with the
database unsynchronized.  

The executable that performs this task is called
dld_sync.exe and is installed in the database directory.
An icon has also been added by the installation.  By
default, this utility synchronizes the database last
accessed by Compass. 

If there are additional databases to synchronize, take the
following steps:

1. Change the database text box to the path for that
database. 

2. Press the UPDATE button to run the utility. If a
Permission Error is reported, the path for the
system.mda may be incorrect. Make sure the
system.mda file is in the exe subdirectory of
Compass. The system.mda grants access
privileges to the database and must be present to
open the database.
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Database Repair

Compass databases may become corrupt if the power to
the PC is shut off while Compass is running.  If the
“Database may be corrupt” error occurs, run the Database
Repair utility.  The name of the executable running the
repair utility is Dbrepair.exe and it is located in the
database directory.  An icon was created by the
installation to run this utility.   

Select the database being reported as corrupt and run the
repair utility on this database. The SEARCH button can be
used to locate the database. Running this utility will repair
and compact the database.  Performing this on a
noncorrupt database will not damage it.  The compact of
the database will get rid of any deleted customers and
shrink the size of the database.  Press the REPAIR button
to execute this utility.

If the database is on a network, we recommend that you
first copy the database to a local directory and repair it
locally. A repair done on a network file can take a very
long time, sometimes never completing.  
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To repair a database,  copy the file being repaired locally
into c:\compass\database. Also copy system.mda from
the network into the c:\compass\exe directory. The
system.mda file must be in that directory in order for the
Database Repair utility to be run.  The repaired database
can then be copied back to the network.

Merge Databases

You can merge two databases together using Merge.exe
(installed into C:\compass\exe by default).  This is useful
when you are dealing with two different company
databases. Merge.exe can also fix the “3033 Attached
table Error.”  The 3033 error occurs when the attachments
to other tables become lost, usually when the machine is
turned off (either by power outage or operator shutdown)
while running Compass.

To fix the 3033 error, take the following steps:

1. Install an empty database in a temporary directory.

2. Insert disk 1 of the Compass installation disks into
the drive and run setup.exe.

3. Direct the installation to install into a temporary
directory (it will be created if it is not already there). 
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4. When the Select Components screen appears,
only select the database to install.

5. Finish the installation.

6. Use the merge.exe icon in \compass\exe directory.
An Administrator-level password must be known
for the “Copy From” database. This will help ensure
security.   

7. Select the old database as the "Copy From"
database and give an Administrator-level operator
password.

8. Select the empty database in the temp directory as
the "Merge Into" database, then press the MERGE
button.

9. Make a backup of the old database and then copy
in the new merged database on top of the old
database.  

When merging two existing databases together, press the
CHECK CONFLICTS button before merging.  This will ensure
that all the  Receiver Group/Account numbers are unique
in the new merged database.  

Merge will not copy over the Operator or

 
Station Data information. Therefore, only
an operator/password combination from
the “Merge Into” database will work. In the
3033 error case, the operator/password
will be master/master.
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The UPDATE STRUCTURE buttons simply run the database
synchronization routine on the specified database.
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Appendix
A
Error Conditions

ERROR:  Cannot find a DLL or VBX file. 

Solution: If this happens, manually copy the files giving
the error from the DLL subdirectory into the Windows/
system directory.

ERROR:  xx parameters expected, but 0 supplied

Solution: This error occurs if the database was not
synchronized properly at the end of an install.  Try running
the database synchronizer again.  It is possible that a DLL
or VBX was not properly moved into the Windows System
directory or that the Compass upgrade was installed into
a different directory than the original directory. To see the
directory where Compass was installed, run Compass
and check the database path on the login screen. The
beginning of this path, before the
\database\download.mdb, is the location of the previous
install.  If this path is not the same as the upgrade,
change the path to match the upgrade directory. 

ERROR: The panel calls back, but the modem never 
answers. 

Solution: This problem is usually generated by a bad
modem cable.  The DTR line of the modem is left open
when this error occurs.  To determine if there is a bad
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modem cable in version 1.2.2.10c or later, take the
following steps:

1. Go to the Communications Menu.

2. Select OPTIONS, then PROBLEMATIC MODEM.

3. Set the Toggle DTR on first command, and set the
Drop DTR to 3.1 seconds.

4. Start a panel-initiated connection using any panel
in the database.  

5. Watch the TR light of Compass and the TR light on
the modem. The TR light should go on and off for
both the Compass software and the modem.  

If this does not happen, the modem cable is a likely
suspect.  If after changing the modem cable, the problem
still occurs when the same test is run, a problem exists on
the cable inside the computer.  

Another option under Problematic Modem  is  Alternate
AT/hangup.  When this option is selected, the DTR line is
no longer used to  get the modem’s attention.  Instead a
guard time, +++ command is used.

ERROR:  “Cannot put modem into command state”

Solution: The 1200 baud modems and the Hayes
Smartmodem 2400 modem are subject to this error. Set
the Communications Option/Problematic Modem Menu
selection of Toggle DTR on first command and set the
Drop DTR 3.1 to seconds.

ERROR:  “Btrieve” error message.  

Solution:  Btrieve is the database used by the Ademco
and First Alert DOS downloaders. If the error occurs when
DOS  conversion is first brought up, it is most likely
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caused by an older version of Wbtrcall.dll being used. To
fix this error, copy wbtrcall.dll from the dll folder of
Compass into the exe folder. 

Solution: Btrieve error displays for certain accounts in the
*.vst file, it indicates real problems in the DOS database.
Run the VLU.exe file in the DOS downloader to repair the
VST file displaying the error.  If that does not repair the
problem, open the account in DOS and see if the account
has data in it or an error message is received.
Sometimes these accounts are unused and do not have
real data.  The DOS conversion can skip over these
accounts.

ERROR:  “Decode.dll” error message.

Solution: This error must be reported to ADEMCO for
repair, along with the following information:  

• The panel type.

• The type of error: “vb value invalid,” “vb type 
length,” “nibble length,” etc.

• The glf_id and the repeat.   

Please export the account and send it to technical support
and to the Windows Downloader Engineering group at
ADEMCO. 

This dll is not backward-compatible, and
may cause problems with other older
software packages. If this dll is replaced,
rename the previous version wbtrcall.wdl
so that it can be put back after the DOS
conversion is completed.
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ERROR: “Get_DDE_Active_Zones” error message.

Solution: This error message should only effect the
bypass of zones and the display of the zone alpha
information on the communications screen. Information
on what panel caused the problem should be forwarded to
ADEMCO Group Technical Support.

ERROR: Cannot find system.mda when 
repairing network database locally

Solution: This is caused when the Database Repair
program cannot find system.mda in a local exe
subdirectory off of the main directory, and the
database.mdb in a local database subdirectory (e.g.,
C:\compass\exe and c:\compass\database). Copy the
system.mda into C:\ Compass\ database, then run the
Repair utility. 

ERROR: Compass running on a Novell Server
suddenly stops allowing anyone to add new
accounts. 

Solution: The reason for this error is that the Novell Server
runs out of locks.  Novell defaults should be:

• Max Records per connection 500>>10,000

• Max File Locks per connection 250>>350

• Max Record Locks?>>20,000

ERROR:  "Permission denied, cannot open sys-
tem.ldb" error message.  

Solution:  This error message may occur when  running
netload.exe from a peer-peer network.  Netload.exe is
designed to speed up a network installation.  To solve this
problem, take the following steps: 
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1. Load the full installation on the network. 

2. Change the shortcut for each of the client
machines to run netload.exe instead of
download.exe.  

3. Netload will check the network drive to see if any of
the files in the exe, dll, or bitmap folders have been
updated.  If any files are newer than those on the
client machine, they are copied to the appropriate
local c:\compass\ subfolder. The client machines
are updated automatically without having to run an
individual install on each machine.

If Compass has been installed on the server machine’s
C:\ drive, the server machine cannot be used to run
Compass using the netload scheme. If the server
machine is running Compass, it puts a lock on the
system.ldb.  If a client machine attempts to run netload, it
will attempt to check for new files and then give the error
message "Permission denied, system.mda open.”  

To solve this problem,  go back to running download.exe
instead of netload.exe.  In this configuration, a new
installation of Compass requires either an update of each
client machine (to run fast with most of Compass local); or
download to be run directly off of the network, which
results in a loss of speed.  Netload is only useful in
keeping the client machines automatically updated; it is
not necessary.

Alternatively, a partitioned drive d: can be set up on the
server and Compass installed to that drive.  The server
and all client machines can then run netload.exe.

Only a network administrator can change these settings.
The Head of the downloading department cannot typically
change these settings.
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ERROR:  "3041 Incompatible database” error mes-
sages.

Solution:  This error occurs when paging software is
running in the background using an older version of either
MSAJT200.DLL or MSAJT112.DLL.  This software has
loaded the older version of these dll’s into memory.  To fix
this situation, don't run the paging software at the same
time as Compass.  Search to find these 2 dll's on the
system.  Compass will put them into c:\windows\system.
It is likely that this paging software has the dll's in its local
directory.  If this is true, rename the dll's in the paging
software directory to *.wdl.  Let the paging software use
the newer dll's installed and see if the two software
packages can both run this way.  Always start Compass
first and then the paging software. This is effectively the
same thing as the newer dll’s will be in memory.

ERROR:  Windows returned Printer Error 482.

Solution:  This usually happens when a 16-bit application
is printing complex pages from Windows 95 to a Network
printer. To solve the problem, take the following steps:

1. Go to Start on the Taskbar. 

2. Click SETTINGS, then click PRINTERS.

3. Right-click the correct printer. 

4. Select PROPERTIES. 

5. Select the DETAILS folder and SPOOL SETTINGS
button. If the default setting is “Start printing after
first page is spooled,” change to “Start printing after
last page is spooled.” 

6. Choose LPT1 from the Print to the Following Port
drop- down box. 

7. Click CAPTURE PRINTER PORT. 
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8. Enter LPT1 in the Device drop down box. 

9. Enter the printer path name in the path box. Printer
paths look like “\\My Server\MyPrinterName.” Make
sure “Reconnect at Logon” is checked. Note: A list
of printer names can be retrieved from the ADD A

PORT button. 

An alternative to this procedure is to select the DETAILS
folder, click on the SPOOLS SETTING button, and then
select PRINT DIRECTLY TO THE PRINTER.
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